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Creating Buttons and Tabbed Interfaces in Photoshop 
By Zac Van Note 
 

The State of the Button 
 
Hyperlinks are the glue that holds the web together. Without an easy way to navigate from page to page, 
we would never find all the useful information on the internet. Of course, blue underlined hyperlinks don’t 
give your site much flexibility. That’s where buttons come in. Buttons have been around on the web for about 
as long as Mosaic brought graphical browsing to the masses back in the early ‘90s. The styles and colors 
have changed over the years: from simple flat color buttons to colorful glossy buttons, we’ve seen it all. There 
now seems to be a fairly even split between approaches to buttons in web interfaces. On one side are the 
minimalist buttons that just give a hint that they’re clickable, often with no graphics in sight. At the other end 
are buttons that take their job seriously and use various graphical tricks to make their ‘clickability’ obvious.  
 
Buttons generally consist of a distinct colored area, a text label in the middle and beveled edges of some 
kind that beckon the user to come over and click it. This much hasn’t changed. If you do a bit of surfing on 
the web, you’ll see lots of flat color buttons, tabs and buttons with gentle gradients, orb or pill-shaped 3-D 
buttons and many variations in between. Most of these buttons include a roll-over effect that changes the 
look of the button or text to make it clear that ‘this thing is clickable’. The roll-over or ‘hover-over’ effect can 
be achieved with or without images or even javascript. Most cutting-edge techniques stress clean code that 
works in any situation which means little or no javascript, and little to no images in navigation. The choice is 
ultimately yours and the content and tone of your site will dictate which approach makes the most sense. 
 
This article discusses the most prominent styles and how you can create them in Photoshop and 
Dreamweaver. Along the way, I’ll give you numerous examples and additional resources. Let’s get started… 
 

3-D Buttons Live! 
 
3-D Buttons come in many varieties, from bubbly plastic-looking tabs to shiny orbs and everything in 
between. In some circles, the over-the-top button style is very popular. Overall, the commercial web has 
been toning it down a bit, but you can find many examples of 3-D buttons on today’s top sites. Apple.com, 
Xbox.com, WebMD.com and Target.com all have 3-D buttons as their primary navigation. 
 

 
 
www.Xbox.com uses buttons and a 3-D interface to create a compelling look that ties into the 3-D worlds 
gamers are used to. 
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Using some of Photoshop’s built-in Layer effects, you can create a convincing button effect in just a few 
steps. Once you’re satisfied, you can save the effects as a Style and reuse it as needed. 
 

Standard 3D Buttons 
 

 
 
1) Create a new document. We’ll be creating just one button for now, so 75 x 40 pixels should be large 
enough. 
 
2) We’ll start with a flat background color to place our button on. Go to Layer > New Fill Layer > Solid Color... 
Give it the name ‘Color Background’ and click OK. Select a color with the color picker and click OK. 
 
3) Create a button shape with the Rounded Corner Rectangle Tool. Make sure you are in Shape Layer mode 
(the first icon on the Options Palette). If you are in Paths Mode or Fill Pixels Mode, you won’t have a stand-
alone shape layer for your effects. I made mine about 65 x 20 pixels. Change the color to white by double-
clicking on the color square on the shape layer. Select white in the color picker. 
 

 
 
4) Fill the button with a gradient. On the layers palette, select the Effects icon and choose Gradient Overlay. 
You can use the default black to white color scheme, select a different one or even make your own. You 
can alter the scale, opacity and even move the gradient starting point right on the screen. Just press on the 
button and drag up or down while still in the effects dialog box. I used these settings; Opacity: 100%, Angle: -
90, Scale: 120%. Once you’re happy with the gradient, click OK. 
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5) Add some text to the button. Select the Type tool and click on the center of the button. Enter the text for 
the button. I’m making a generic ‘Home’ button. I used the typeface ‘Minion’ which comes with Photoshop 
CS/CS2. Make sure you anti-alias the type. Depending on the typeface and size, different anti-aliasing 
methods will yield very different results. Try each until you get a good feel for which works in each situation. 
Another tip to make your small text more readable is to space your letters out a bit. This is called tracking. 
You’ll have to click on the palette icon toward the end of the Options Palette. Open the Character options 
and click on the down arrow next to Tracking. Select 5 or 10. This can really help keep your text readable 
and can make the anti-aliasing look crisper. 
 
6) Add some effects to give the button a 3-D appearance. Make sure you’re on the button layer. From the 
Layer Effects menu select Pillow Emboss. Change the technique to “Chisel Soft” and play with the settings 
until you’re satisfied. I used these settings: Depth: 200%, Size: 0, Soften: 2, Angle: 120, Altitude: 30. 
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7) Next, apply the Stroke effect and set the size to 1 pixel. Change the stroke color to black or dark grey. 
 
8) For some added dimension, you can add an Inner Shadow effect. I changed these settings; Opacity: 33%, 
Angle: 120, Distance: 4, Size: 5. 
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9) Now you’ve got a complete button. You can duplicate the button and change the text or you can 
create styles for later use. 
 

Adding Some Style 
 
To make all this work a bit easier to apply on your next button, open the Styles Palette. Select the layer that 
contains your button and all the effects. Click on the New Style button at the bottom of the Styles Palette. 
Give it a name, like ‘3D Button’. Now you can draw any shape on a layer, click on this button in the Styles 
Palette and instantly have a new button.  
 
 

Plastic 3D Buttons 
 

 
 
The plastic 3D look was made popular by Apple back around the time of the first iMacs, in all their plastic, 
candy-colored glory. Their revolutionary take on the computer ‘box’ changed industrial design and the 
effect spilled over to the online world. Apple still uses this liquid, plastic look on its website and throughout the 
OS X ‘Aqua’ interface. There are various ways to get this look. Here’s one effective way: 
 
1) Create a new document. We’ll be creating just one button for now, so 75 x 40 pixels should be large 
enough. 
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2) Select the foreground color you want as the main color of your button. Create a button shape with the 
Rounded Corner Rectangle Tool. Make sure you are in Shape Layer mode.  
 
3) Select the layer and from the layers Palette menu, select Blending Options. Change Fill Opacity to 80%, 
Select Blend Interior Effects as Group and Transparency Shapes Layer. Uncheck the other three options 
under the Knockout menu. 
 

 
 
4) Click on the layer effects icon at the bottom of the layers palette and select Inner Shadow. Change the 
color (I used #025096). Set the opacity to 85%, Distance to 8, Choke to 25 and Size to 16. Stay in the layer 
effects dialog box. 
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5) While you’re still looking at effects, check on Outer Glow on the left and click on the label Outer Glow to 
make sure those are the settings you’re changing on the right. Change the color (I used #44CAFE). Set the 
Opacity to 40%, Technique to Softer, Spread to 0, Size to 5.  
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6) Next, check on Inner Glow. Change the color to white. Set the Blend Mode to Color Dodge, Opacity to 
50%, Technique to Softer, Source to Center, Choke to 0 and Size to 3. 
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7) Just a few more effects and we’re done. Check on Bevel & Emboss. Change the Style to Inner Bevel, 
Technique to Smooth, Depth to 100, Size to 8, Soften to 2, Angle to 90, Altitude to 65. 
  

 
 
8) Under the Bevel and Emboss category on the left, there’s two sub-options. Check on Contour. On the 
right, click on the thumbnail next to the label Contour: This will open up an editable curve. Drag one point 
from the line up and to the right as pictured below. Draw a second point down and to the left.   
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9) Now, click on Satin. Change the color (I used #60ACFF), set the Blend Mode to Overlay, change the 
Angle to 90, Distance to 28, Size to 28, make sure Anti-aliased and Invert are both checked and select the 
‘Ring’ Contour style. 
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10) Now, click on Drop Shadow. Set Opacity to 35, change the Angle to 120, Distance to 3, Spread to 0, Size 
to 8. Make sure Layer Knocks Out Drop Shadow is checked on. 
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11) Click OK to exit the layer effects dialog box.  
 
12) Add a new text layer on top of the button with your desired text. 
 

 
 
13) You’re done! 
 
  

3D Orbs 
 

 
 
Sometimes you want an even more dimensional look. Because a circle or oval will have different reflective 
properties than a rectangular or pill-shaped button, the approach is a bit different: 
 
1) Create a new document. We’ll be creating just one button for now, so 75 x 75 pixels should be large 
enough. 
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2) Select the foreground color you want as the main color of your button. Create a button shape with the 
Ellipse Tool. Make sure you are in Shape Layer mode and hold shift as you draw your shape to create a 
perfect circle.  
 
3) Make sure the background color is white. Go to the layer effects pop-up menu on the layers palette and 
select Gradient Overlay. Choose foreground to background, click on Reverse and set the Opacity to 85%. 
 

 
 
4) Add a Stroke layer effect. Change Size to 1 and the Color to a dark blue-grey (I used #5F6684 
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5) Create a new oval shape layer for the highlight. Go to the layer effects pop-up menu on the layers 
palette and select Gradient Overlay. Choose foreground to background, click off Reverse and set the 
Opacity to 75%. 
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6) Add some text and you’ve got a ‘dew drop’ 3D orb. 
 
 

The Almighty Gradient 
 
Out of all the trends, the gradient seems to be making the rounds as the flavor of the year. Sites from 
Amazon.com to MSN.com and AOL.com are all using gradients in their navigation designs. Gradients can be 
subtle or in-your-face and either approach can help get your site’s attitude across. 

 
 
Amazon has added the popular gradient look to an updated version of its tabbed interface. 
 
Let’s take a look at a subtle gradient tab or button technique like the one used at www.amazon.com. 
Before we get started, just a word about tabs—The tab metaphor works best when it mimics real-world tabs 
on file folders. When you flip to a tab, you know that the information you want is contained inside that folder. 
On the web, when you click a tab, it should change color and become one with the content or sub-
navigation below it. Otherwise, you may as well just use plain-old buttons. 
 

 
 
1) Create a new document. We’ll be creating two tabs for now, so 150 x 60 pixels should be large enough. 
Once the document is open, make the image window bigger than the image area so you can see the gray 
background around the image. 
 
2) Create a ‘base’ for your tabs. Draw a rectangular shape layer about 2/3 up from the bottom of the 
image. In the Options Bar, click on the Add to Shape Area icon. Using the Rounded Rectangle Tool with a 
Radius of 8px, draw a tab that extends almost from the top of the image into the rectangular area below. 
Make sure to draw this shape deep enough to hide the lower round edges. Because these are editable 
shapes, you can easily make the tabs larger or smaller using the Direct Selection Tool.  
 

 
 
3) Set your foreground color to the darker color of your gradient (I used #3881A9). Set the background color 
to the lighter gradient color (I used #EFF9FD). Apply a Gradient Overlay layer effect. Select Foreground to 
Background as your gradient style. You may wish to adjust the scale a bit. 
 
4) Apply a Stroke layer effect. Change the color (I used #E3E3CD) and Stroke to 1. 
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5) Add an Inner Shadow layer effect. Change Opacity to 80, Angle to -90, Distance to 1 and Size to 4. Click 
on the thumbnail image next to Contour. This will bring up an editable curve. Drag the two points out to 
create a curve as pictured below. 
 

 
 
6) Add a text layer with the text ‘Link 1’. Style it as desired and position it in the center of the tab. 
 
7) Now we can duplicate this layer to create a new tab. Click on the outline of the rounded rectangle with 
the Path Selection Tool. Once selected, use the arrow keys on the keyboard to nudge it to the right. 

 
 
8) Change your foreground color (I used #3881A9) and background color (I used #EFF9FD). Double click on 
the Gradient Overlay of this new layer. Change the gradient type to Foreground to Background to update 
the gradient with the new colors.  
 
9) Duplicate your text label, change the text to ‘Link 2’ and move it to the center of your new tab. 
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Now you’ve got two tabs. You can use the same technique to make as many as needed. Once you’ve got 
the tabs the way you want them, you’ll want to slice them up and possibly add rollovers. See the Rollover 
section below for more information on the next steps you can take.  
 
Tip 
 
Gradients are a popular look and tabs are just as popular. Creating a site with many tabs can be a logistical 
nightmare when it comes to updating the site navigation. One creative approach involves Cascading Style 
Sheets (CSS) and some small images to create tabs with editable text. With this technique you can get the 
tab look and functionality, but keep the flexibility to change the tab labels anytime you want. Unfortunately, 
this technique is a little tricky to implement and requires a fairly strong understanding of HTML and CSS. 
However, the results can be well worth the learning curve. Read more about this technique at 
http://www.alistapart.com/articles/slidingdoors/ and http://www.alistapart.com/articles/slidingdoors2/
 
 

Look Mom! No Images! Using CSS ‘buttons’ 
 
Flat color buttons are largely due to the shift away from slow-loading graphics, buggy javascript and non-
standard HTML. Now attractive ‘buttons’ can be fashioned out of pure (x)HTML and CSS with little or no 
Photoshop involved. Nearly everyone is now using browsers that make Cascading Style Sheets for layout a 
reality (give or take some annoying bugs).  
 

 
 
Many sites, like www.alistapart.com, use CSS menus to minimize download time, increase compatibility 
across devices and maintain search-engine friendly design. 
 
CSS may not be the flashiest method, but there are certainly benefits to this approach. It means fast loading 
times and easy maintenance. Separating the content from the formatting also makes the content portable, 
so you can view it on a large or small screen (like a PDA) and print it reliably.  
 
There are many other articles on CSS and since this is primarily a Photoshop tutorial I will only include one 
simple method. For more, I encourage you to look around www.DMXZone.com, www.alistapart.com, and 
www.cssZenGarden.com for more techniques and inspiration. 
 
DMXZone actually provides a great, free Dreamweaver extension for creating CSS navigation called List-O-
Rama by George Petrov. It’s a simple little tool that makes horizontal or vertical menus a snap. Because you 
just have to answer a few questions and it builds the menus for you, it’s really the easiest way to get a great 
looking, standards-compliant menu on your site. If you’d like to understand a bit more of what’s happening 
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behind the scenes, check out George’s original inspiration at http://css.maxdesign.com.au/index.htm or 
http://www.accessify.com/tools-and-wizards/list-o-matic/list-o-matic.asp?step=1. 
 

Making List-O-Rama Work 
 
First, you’ve got to download the Dreamweaver extension at 
http://dmxzone.com/index.asp?TypeId=3&CatId=459. You’ve got to log in to download it.  
 
Next, just click download and choose Open. It should open the Macromedia Extension Manager and auto-
install for use in Dreamweaver.  
 
You’ll find the icon at the end of the Common Insert Panel. Just click it and follow the instructions.  
 
Enter the text and URL link for your first ‘button’, click the ‘+’ at the top of the dialog box and enter additional 
links. You can change their order with the arrows at top.  
 

 
 
When you click next, you can choose from 5 horizontal and 5 vertical styles. Click OK and you’re all done. If 
you know a bit of HTML and CSS, you can easily add more items and tweak the visual look of your links. 
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This approach has many advantages and few downsides: 
 

• creates a sophisticated roll-over menu (only 2 states) 
 

• uses no javascript (faster downloads, reliable functionality) 
 

• uses no images (faster downloads) 
 

• some really old browsers won’t show the rollover state 
 
On the CSS side, my only complaint is this extension doesn’t add the styles it creates to an external style 
sheet that can be shared across the entire site. It places the style rules in the head of the document. Of 
course, it’s fairly easy to copy and paste these rules to an external style sheet. 
 
 

Rollovers 
Once we have the basic buttons designed, we need to determine if we want to create a rollover state. 
Photoshop doesn’t help much in this regard, but ImageReady can be used to automate this process. Most 
folks create their menus as one big file in Photoshop and move to ImageReady to slice up the buttons into 
individual pieces. Then you can create rollover states for each button separately. ImageReady allows for 
multiple rollover states and complex changes to multiple slices. However, this generates loads of javascript 
and multiple images, which makes it more desirable to keep it simple. Most sites stick to two-state rollovers, so 
that’s what we’ll focus on here. 
 

 
 
Open the 3D orb image we created earlier in Photoshop.  
 
Make sure your background color is white. Using Image > Add Canvas, add 75px of canvas to the right of 
the image. 
 
Select the button shape layer. Add a new Color Overlay layer effect. Change the Blend Mode to Color. 
Change the color (I used # 6FD183). We’ll be able to toggle this effect on and off to create the rollover 
effect. 
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Select the highlight shape layer and add a Color Overlay effect with the same settings as step 3. 
 
Create a layer group using folder icon at bottom of Layer Palette. Name it ‘Link 1’. Drag all of your layers, 
except the Background layer into the new group. 
 

 
 
Duplicate the layer group by dragging to the New Layer icon at the bottom of the Layers Palette. This will 
create an exact duplicate. Drag the group using the Move Tool right on the image canvas. You can also use 
the right arrow key to nudge it to the right. Label the layer group ‘Link 2’. 
 
Change the text on the buttons to read ‘Link 1’ and ‘Link 2’ in their respective groups. 
 
Now we’ve got two green buttons with a blue color change for a rollover effect. Open ImageReady with 
the button at the bottom of the Photoshop toolbar. 
 

 
 
Using the slice tool (it looks like a scalpel), draw a box from edge to edge around the first button.  
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Draw a second slice around the remaining area. Make sure you only have two slices. They should touch in 
the middle and extend from edge to edge. 
 

 
 
Open the Web Interface  
??? 
Palette and click on the first slice (Link 1). At the bottom of the palette, click on the New Rollover button. This 
will create a new state for the slice and will be indented a bit. With the new state highlighted, go to your Link 
1 layer group and turn off the Color Overlay visibility for both the button and highlight. 
 
That’s it! You’ve created a rollover effect. Now do the same thing for Link 2.  
 
When you’re done, you’ll want to make sure it works. On the Toolbar, click on the Preview Document mode 
(pointing finger icon). Roll your mouse over each slice and you should see the desired effect. Save the file as 
a PSD file. This will allow you to come back and make changes at any time, with layers intact. 
 

 
 
To export this as a real web page, complete with the javascript used to swap the images, go to File > Save 
Optimized. It will create an HTML page with the necessary javascript. It will also create 4 images (2 states 
each for Link 1 and 2). It will save them by default with the name of the file. For ‘over’ states, it will append ‘–
over’ to the file name.  
 
Now you’ve got a working web page. Some designers will take this page and start adding content to it. If 
you are working in Dreamweaver, I would recommend trashing the HTML ImageReady generated and start 
with a fresh file in DW. Create a rollover using DW’s built-in rollover behavior. If you change file names or 
locations, DW will track the changes and update the javascript. If you bring ImageReady’s javascript into 
DW, it won’t be automatically tracked and updated. It’s really easy to start breaking links this way. 
 
Another method is to setup the two states side-by-side in one image. You can then use CSS positioning (CSS-
P) to ‘slide’ the image back and forth. For more information on this technique, visit http://wellstyled.com/css-
nopreload-rollovers.html. For an example, visit http://wellstyled.com/files/css-nopreload-
rollovers/example.html. 
 
There’s another related concept that uses small ‘sprites’ to store all of your buttons or icons in one image file. 
You can then use CSS-P, much like the technique above to show or hide the individual ‘sprites’. Read Dave 
Shea’s article at http://www.alistapart.com/articles/sprites. 
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Other Navigation Methods 
 
I intentionally limited the scope of this article to focus on buttons and tabs. Of course there are many other 
ways to create your navigation, from plain text to fancy Flash-driven interfaces to cascading menu systems. I 
couldn’t possibly give you an exhaustive set of links, but here’s some excellent DMXZone tutorials and 
resources: 
 
Layer Genie (Menu extension for Dreamweaver): 
http://dmxzone.com/showDetail.asp?TypeId=3&NewsId=4353
 
DHTML Flyout Menus: http://dmxzone.com/ShowDetail.asp?NewsId=5802
  
Flash Menus: http://dmxzone.com/showDetail.asp?TypeId=9&NewsId=5715
 
Interface Widgets: http://dmxzone.com/showDetail.asp?TypeId=28&NewsId=10607&LinkFile=page1.htm
 

Wrap Up 
 
Buttons, now matter how they look, are an important element in web design. Though the current trends lean 
toward minimal rectangles, simple gradients and the occasional 3D button, who knows what will be in 
vogue next month or next year. For a well-versed designer, mastering each of these techniques is important 
so you can change with the times and more importantly, design sites that have the appropriate tone and 
functionality for your clients. 
 
I would love to hear your comments and creative navigation solutions. Please post your comments to this 
article or contact me directly at: zac@creativefuel.org
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